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 OVERVIEW 

Tune 1.5 features some dramatic user interface and functional changes when compared to Tune 1.4. The goal of these 

changes is to optimise the user’s workflow whether it be tuning or configuration of a Package in offline and online 

scenarios. 

The purpose of this document is to outline many of the key user differences for Tune 1.5 to enable users to navigate and 

become familiar with the new workflow operating in the new M1 Tune 1.5 software, as well as to help identify new 

features that have been implemented.  

 

 FIRST INSTALL IMPORTANT NOTE 

On the initial installation of M1 Tune, please ensure the first ‘check for updates’ completes before attempting to use the 

software. The installer does not bundle any of the workspaces or associated files, so for the intended ‘out of box’ 

experience, please allow the workspaces and rules to download and install before use. 

 

 HOME SCREEN 

The new look home screen now centres around a quick launch layout as shown below: 

 

Figure 1 – New Tune 1.5 Home screen 
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The home screen layout has three main sections. Circled in yellow in Figure 1 on the left side of screen is recently used 

Packages. This list can now show more Packages than previously in Tune 1.4, as well as identifying newly installed 

Packages in yellow. It should be noted that this list has no ties with Packages interacted with in Tune 1.4. 

Clicking any of these buttons will open the Package. Otherwise clicking on the green button will launch the “Open 

Packages ...” dialogue. 

On the right of screen circled in red in Figure 1 is the online ECU’s area.  Any M1 ECUs discovered will appear in the right-

hand side list. This list will automatically update, or the green Connect to ECU… button can be selected to open the ECU 

select popup dialogue. 

There are 5 quick launch buttons at the top centre of the window circled with Cyan on figure 1. These are: 

1. Retrieve Logging quick launch retrieval of logged data as a complementary option to the icon in the task bar at the 

top of screen.  

2. Check For Updates button for manually triggering the check for Package, workspace or software updates.  

3. WWW.motec.com.au Quick launch your default browser and navigate to the MoTeC website. 

4. Download Packages button, which will launch your default browser and navigate to the firmware downloads page 

on MoTeC Online. 

5.  About button, which will launch the software information popup. 

 

 TOOLBAR ICONS 

The toolbar quick launch functions have been updated from Tune 1.4 to optimise most workflows. 

 

Figure 2 – Tune 1.5 toolbar 

The function of each of these buttons is outlined below. 

 OPEN PACKAGE – This is a shortcut button to launch the open Packages window. This allows you to open a different 

Package in the currently opened workspace. 

 OPEN ECU – This is a shortcut button for showing the available ECUs that can be connected to. This will connect to 

the ECU in the currently open workspace.  

 HOME – This button will exit any open workspace or Package and return you to the home screen.  

 SAVE – Save current state of Package. If online to an ECU, commit the contents. This is the same function as the  

CTRL + S keystrokes. 

 SEND PACKAGE – Send the current state of the Package to the ECU. 
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 UNDO – This button will undo the last data change the user has made. This is the same function as CTRL + Z 

keystrokes. NOTE: This function only works for the single last data change, this will not work for multiple steps. 

 REDO – This button will redo the last data change the user has made. This is the same function as CTRL + Y 

keystrokes. NOTE: This function only works for the single last data change, this will not work for multiple steps. 

 BACK – This button will take you to the previously selected adjust item. This is the same function as the F10 key. 

NOTE: This function only works for the single last configuration selection, this will not work for multiple steps. 

 ADVANCE TOGGLE – This button will toggle on and off the visibility of advanced tables, parameters and channels in 

the workspace. 

 DOWNLOAD LOGGED DATA – For the retrieval of logged data from a connected ECU. This is the same function as the 

CTRL + F8 keystrokes. 

 ADD COMPARE PACKAGE – This button will trigger the add compare Package function, launching the open Package 

pop-up.  

 CLOSE COMPARE PACKAGE – This button will close the loaded compare Package. NOTE: The active Package in its last 

saved state is always active in the compare system, which cannot be closed. 

 SWAP MAIN/COMPARE PACKAGES – This button will swap the currently active Main and Compare package. Offline 

use only. 

 COMPARE PACKAGE DIFFERENCES – This button will launch the compare Package dialogue. As the last saved state is 

always loaded as a compare file, the user has the ability to track any changes made since the last save operation.  

 TOGGLE COMPARE FUNCTION – This will toggle on and off the compare differences overlay function of the Package 

compare. This is the same function as the F4 keystroke. 

 TOGGLE FULLSCREEN MODE [ F11 ] – This will change the M1 Tune application window into full screen mode. 

 PAUSE ACTIVE TELEMETRY – This will toggle the playback / pause of the current telemetry data in the time graphs. 

This has the same function as the A keystroke. 

  NOTE 

  The function of the T and A keystrokes has reversed in Tune 1.5 to allow for consistency with the i2 application. 
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 NAVIGATION – These buttons navigate to the Guide, Help, Review items, Search and Channel list 

Guides and Review items are new functionality implemented in Tune 1.5 to aid in configuration and tuning workflow.  

 

Guide [new] 

This exists separately to the context help to allow firmware developers to follow a process – whether it be a procedure for 

configuring the Package to get their application up and running, or an area to document a guided component test. The 

guide can only be written into a firmware Package via M1 Build.  

 

Figure 3 – The top level guide written into GP Packages 

The list of guides can be navigated from the dropdown in the flyout pane. 

 

Figure 4 – List of guides embedded into the firmware Package 

Many of the latest release GP firmwares already have some guides populated in the firmware, which can be reviewed for 

reference. The benefits of this are that there is less of a need for documentation to be provided with a given firmware, and 

the guide can be accurate for the version of firmware being utilised, i.e. if a control strategy is updated, requiring different 

setup and configuration, the guide can be updated to remain accurate for that version of firmware.  
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Help [new] 

The help in Tune 1.5, which can be reached via the  key, can now be dynamically navigated to aid in the user’s 
understanding of complex control strategies such as torque control, gear shift or traction control. This dynamic function 
also allows the user to be directed to the parameter (or table) that requires configuration by clicking on the highlighted  
name inside the help. The user interaction with the help from Tune 1.5 has been revised to allow easier user interaction 
with firmware.  

 

Figure 5 – Help key words and navigation tiles in the Help context flyout shown 

The displayed help will now show a breadcrumb menu of each help item, which is based on the help grouping as viewed in 

M1 Tune via Help > Firmware Help… (circled in red). This allows the user to navigate the help tree by clicking on the tiles 

instead of requiring a click directly on a parameter to raise the relevant help. Navigating back and forth through previously 

viewed help is now possible by using the back and forward buttons in the help pane (circled in cyan). 

 

Figure 6 – An example of navigating the help dynamically whilst configuring a complex control strategy such as gear shift 

To further aid in user navigation of the help, parameters which are highlighted in blue in the help text can now be 

automatically raised in the adjust worksheet, whilst keeping the currently help topic raised to allow a user to read through 

the help and check the configuration of each parameter affecting the selected control strategy in a systematic way. In 

Figure 6, the help has been navigated to ‘Gear Shift’ (by pressing F1). From here it has referenced the gear shift state help, 

which has been navigated to by clicking on the ‘Gear Shift State” text (circled in yellow).  

With this help now showing, the parameters can be reviewed such as Gear Shift Fuel Cut Main (circled in red), which, once 

clicked on, has raised this parameter in the worksheet. If the user needs to read the help for this parameter when 

configuring it, they can press F1 whilst on the worksheet, which will update the help to the current item and using the 

back key in the help, they can go back to the previous help if needed. 
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Review [new] 

The review system, which can be reached by the  shortcut, allows for marking of parameters that will populate a 

checklist under the review header. This allows for the user to mark a parameter as a reminder of something that they need 

to come back to at a later stage in the engine tuning process, or for an easier way to mark items that need validation when 

working remotely or in a team environment as the marking of these parameters is also stored in the ECU. 

 

 

Figure 7 – A worksheet with review items marked  

To mark an item for review, select the parameter or calibration table that requires tagging and select the yellow star on 

the top right corner of the worksheet. When the item is marked for review, it is easy to identify as the unit’s column will 

be highlighted in yellow as well as being added to the review checklist. 

 

Figure 8 – Review list as well as a notification that the engine output test is currently active 

All items marked for review will populate in the Review list and allow for navigation to these items when clicked on. The 

review list will also show any test modes that are presently active. There is also a separate migration review function that 

is covered later in the Workspace section of this document. 

 

KEYBOARD SHORTCUTS: 

  Mark item for review 

  Unmark item for review 
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Search 

The search bar is the final item in help pane. This search bar allows searching for all parameters and channels contained in 
the Package, which will be listed in alphabetical order. Any channel or parameter that is currently hidden due to 
configuration settings such as the control strategy being set to ‘Not in use’ will appear greyed out. 

 

Figure 9 – The search pane showing a list of active and inactive channels and parameters in the loaded Package. 

From this search bar, you can drag and drop channels into a time graph, or double click on the channel to view the channel 
properties which will be launched in a popup window. A single click on a parameter or resource selection will navigate 
through the adjust tree and raise the first worksheet containing the selected item. Double clicking on the parameter or 
resource will launch a properties popup window.   
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 WORKSPACE 

Once an offline Package is selected the workspace will be opened. Workspaces are now handled differently, which is 

covered in more depth later in this user guide under the Workspace advanced notes. 

 

Figure 10 – Workspace view on initial load of Package or connection to an ECU 

On initial Package load, the first item in the workspace will be loaded in a maximised layout as shown in figure 10, with 

only the navigation pane available on the left-hand side of screen. By pressing the Maximise/minimise radio button, or 

pressing the  key, the additional areas of the workspace will appear. This view will also be loaded on connection to an 

ECU from the home screen: 

 

Figure 11 – All workspace elements displayed 
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The active workspace Is broken down into 4 main areas the user will interact with when using Tune 1.5: 

Green – The Adjust group. This is the workspace navigation menu for the workspace or firmware groups of 

configuration parameters  

Cyan – The time graph area. This is where the ECU telemetry is intended to be viewed on time graphs. There is an Auto 

Graph Tab which will match based on the Adjust Group you have active for calibration. The Upper portion of this time 

graph space contains a time graph which is to be populated with channels that you always want to see, regardless of 

where you are working. The lower portion of this Time graph space is for a status grid to populate with relevant 

channels that are relevant, but not best represented in a time graph format.  

Magenta – The Workspace Dashboard. This area is for displaying any gauges or other information you would like 

visible in a graphical format for monitoring any running parameters when tuning. 

Red - The worksheet. The contents displayed here will be subject to what is currently navigated to in the Adjust tree 

on the left side of the screen.  

Orange – The active item toolbar buttons. These were previously located in the task bar in Tune 1.4 but have been 

relocated in Tune 1.5. These are the buttons for common operations when interacting with tables or parameters and 

will become greyed out when not applicable to the current focus item.  

Brown – The configuration sidebar. This is where you switch between the main configuration groups such as resource 

assignment and sensor configuration, logging configuration and firmware summary. 

 NEW FEATURES 

A host of new workspace feature and views have been implemented with this completely redesigned M1Tune 1.5 

software, to streamline workflow for both configuration and tuning of ECUs along with introducing more tools and views 

from our analysis software to give increased ability for analysis of real-time telemetry when online with an ECU. 

  Table View – Sliced 

A table slice view has been added in Tune 1.5 for another form of data visualisation.  

 

Figure 12 – Slice view shown for the efficiency table 

The transparency of the inactive data slices can have their transparency adjusted via Tools > Options > Tables. The colour 

of the slice view is defined by the colour assigned to the Channel.  
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Map Trace 

A map trace function has been added to Tune 1.5 for easier visualisation of tracing the area of a table that an engine has 

been operating through. The trace function can be configured to be dots or a combination of dots and a line with a user 

definable time period for the trace to cover. 

 

Figure 13 – Map Trace operating through the efficiency table during a dyno run 

If this feature is not desired, it can also be disabled via the table toolbar button , or the  keyboard shortcut.  

 

Status Grids 

A status grid gauge has been added in for Tune 1.5. This allows for quickly configuring an array of data that is more 

intuitively represented in a numeric or text format as opposed to a time graph, or channel list that often requires 

scrollbars. This also allows for using the warning and fault limits of numeric channels to change the reported colour of the 

channel window. Diagnostic channels can also have each enumeration colour coded to suit the user’s preference in the 

channel properties.  

 

Figure 14 – Status Gride Selection, Configuration and Output 
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Touch Enabled Interfaces 

To make Tune 1.5 more friendly for touchscreen capable devices, several touch controls have been added to the 

calibration parameters. Several of the interface buttons are still visible for non-touch screen users if the preference is 

selected, however items such as the keypad will only be visible to users with touchscreens.  

 

Figure 15 – Touch Dial and Up / Down Buttons 

The touch controls can also be actuated with a mouse on non-touchscreen devices and the new graphical interface makes 

it easier to identify where a parameter is currently defined in comparison to the validation limits set for it. In table views, 

these touch interface items can show displayed or hidden via toggling the ‘K’ key. 

 

Package Key Management and Auto Login 

Tune 1.5 now has enabled an additional mechanism for the handling of security enabled Packages. Along with the Default 

Login security user, an Auto Login Key function has been added to the software. With this functionality, any Package that 

has been loaded, or ecu connected to that has a key based security user option configured can be logged into 

automatically.  

 

Figure 16 – Auto Login Configuration as managed through Tools > Options > General 

This is done by setting a folder containing all of the Package security keys in the options menu. It is recommended to use 

the default directory assigned for this function on installation of the software, which will be found under Documents > 

MoTeC > M1 > Tune > Auto Login Keys 
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Marking Parameters for Review on Migration 

To aid in Package migration to newer versions of firmware, a feature has been added to mark migration items for review 

which makes Package migration easier to navigate. This system works with the review system that was previously 

described allowing you to mark all or any items you deem relevant that were flagged with a warning on the migration 

process. 

To make identification of these items easier when compared to items that were already marked for review, these items 

are noted in the review list with a different icon and under a Migration heading.   

 

Figure 17 – Warnings flagged in a Package migration can now selectively be marked for review 

Data Export 

A new feature which has been added to Tune 1.5 is the ability to export the ECU telemetry data from the time graph into 

an LD file for review at a later point in time. The requirements for this are that the connected ECU has at least level 2 

logging and if the ECU has pro analysis enabled, the exported log file will be an i2 Pro log file. There will also be an 

activation offered for Tune 1.5 for allowing of PC logging, which will allow data export even when an ECU only has the 

included level 1 logging.  

 

Figure 18 – Export of ECU telemetry via the File Menu 
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The data in the exported log file will only be available at the telemetry rate (up to 50hz), but it is possible with the 

correctly enabled ECU to have a logging file with all ECU channels logged, which can help in instances where a log set has 

not been configured optimally, or an unexpected behaviour occurs during tuning allowing for it to be captured. These log 

files are easily identified as the begin with a DAQ_ prefix instead of S1_, S2_ etc. The memory reserved for telemetry data 

has been increased from 1024mb up to 4096mb, allowing for a longer period of data to be retained in the time graph.  

 

Data Import 

In partnership with the ability to export ECU telemetry data out of Tune 1.5, the ability to bring logged data into Tune for 

offline tuning and review has been implemented. This functionality is only compatible with i2 Pro, so any standard log file 

will require an activation in i2 Pro to open. To launch the data log view window, press the  key. 

 

Figure 19 – Logged data can be read into the telemetry view of Tune 1.5 from i2 Pro 

The population of the telemetry data is only possible when offline from an ECU, however this greatly improves the ease of 

remote tuning and support. Provided the axis channels of tables are in the logged data that is read in, all cursors and trace 

functions will operate the same as when online with an ECU reviewing paused or live data. Quick calibrate functionality is 

also possible when telemetry data is read into Tune using this method, providing that all the channels that are required for 

the calibration are present.  

 

Figure 20 – Quick Lambda functioning during offline tuning when loaded telemetry data is populated from i2 
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NOTES FOR DATA IMPORT 

Although a powerful feature, care should be taken when utilising this functionality for tuning purposes. When populating 

the M1 Tune telemetry graph with logged data, there is no error checking completed. The log file open in the ‘current’ 

instance of i2 Pro will be read in, with the data being populated on a name match basis. This means that if channels are 

manipulated in the loaded i2 workspace via aliases or maths, they will be loaded in M1 Tune in the manipulated state. This 

also means that importing of non M1 origin logged data is possible. 

Channel Abbreviations 

With the ever-increasing complexity of Packages and as a result the names of channels and parameters populating them 

channel abbreviations have been introduced in Tune 1.5.  

 

Figure 21 – Channel abbreviation dictionaries are selected or disabled from the bottom right of screen. 

At the initial time of release for the software, it is only possible to use the AUTOSAR abbreviation dictionary, MoTeC 

dictionary or disable abbreviations. It should be noted that the channel abbreviation selected is independent of the 

abbreviation selection in i2 (depending on build version of i2 installed), although they reference the same source files.  

Q Calibration from Time Graph 

To improve workflow during engine tuning, it is now possible to quick calibrate a table site whilst the focus is still in the 

time graph, instead of being required to click into the table to make this the focus area to calibrate a site, only to have to 

try and click back into the same spot on a time graph.  

This new functionality now allows for quicker calibration of efficiency tables, boost feed forward main tables and multiple 

other tuning tables that are tied to a quick calibrate function.  

Compare to Last Saved State 

Tune 1.5 keeps a ‘snapshot’ of the last save state of a Package, regardless of whether editing of a Package is taking place 

online or offline. This compare state is always loaded and selectable, even when a compare Package is manually loaded. 

 

Figure 22 – Comparing of currently loaded Package compared to the last time the Package was saved. 
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It is possible to compare the changes made since the last save either by the migrate data window via filter by difference, 

or by toggling the compare function with the F4 key to compare while in the worksheet. With this functionality, if you have 

a compare Package loaded for active compare and close the compare Package, the compare will remain active with the 

last save state loaded as the compare Package. 

To change this behaviour, the following option should be unticked in the Options > General menu:  

 

Hidden Channels 

To aid in configuration of workspaces and time graphs it is now possible to view ‘hidden’ channels. A channel is hidden 

when it belongs to a subsystem that is in an inactive state.  

 

Figure 23 – Toggling hidden channels on in the channel list 

This allows for ease of configuration for status grids, time graphs or even diagnostics of identifying if an expected channel 

is inactive. This function can only be enabled via a registry key. 

 

Driver Switch Assignment Viewing 

To aid in the identification of what driver switch based resources are assigned to in a Package, a driver switch assignment 

view has been added to the firmware help. This will show what switch indexes are currently assigned to a driver switch 

resource. It should be noted that if a driver switch resource is currently configured but is not being utilised for a switch 

index or switch function in the firmware, the driver resource will not show up in the driver switch page. 

 

Figure 24 – Driver switch allocation view as shown in the firmware help 
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 SIDEBAR NAVIGATION 

For navigating through other functions outside of adjust group and its contained worksheets, a sidebar tab is present on 

the far left side of screen. Any of these workbooks can be moved to a secondary window by right clicking on the tile and 

selecting move to secondary window. To increase available screen real estate, the  button can be pressed to hide the 

sidebar. To make the sidebar visible again, move your mouse to the left hand side of the screen. 

 

SUMMARY – Raises a workbook which has ECU and Firmware details. 

RESOURCES – Navigates to a resource assignment, sensor calibration and pinout. 

FEATURES – An area that will list operating parameters that can be toggled. 

ADJUST – Location of the adjust tree. 

LOGGING – Navigates to the logging setup. 

ZERO SENSORS – A targeted workbook for calibration of offset and scale parameters. 

STATUS – A status grid for firmware diagnostics grouped into categories. 

ALARMS – A list of alarms (same function as ‘F3’) 

MONITOR – A page for dedicated real time value monitoring. 

NOTIFICATIONS – Software notifications for Package and workspace updates. 

Figure 25 – Sidebar 

When screen-space is at a premium, the adjust groups can additionally be collapsed by clicking on the burger button  

next to the search box, which will collapse this navigation tree down just the current worksheet description.  

 

Figure 26 – Collapsing the Adjust Groups via clicking of the burger button. Also, Sidebar hiding shown. 

A comprehensive description of the workspaces raised by each sidebar button follows. 
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Find Box 

In instances where you are unable to find a parameter you are looking to calibrate the find search bar will show instances 

of your search term in chronological order through the Adjust Tree, followed by the instances in the firmware. Parameters 

that are not matched in any of the worksheets will show up under the firmware header.  

 

Figure 27 – The search box in use, first showing matches in the Adjust tree, followed by the firmware matches. 

 

Summary 

The summary page contains the details of the loaded Package including Package variant, target ECU serial number, vehicle 

ID and the Package summary, all of which can be edited by clicking on the edit tile  for the corresponding header. Also 

present is the firmware version summary, allowing for quick and easy review of any and all migration notes.  

 

Figure 28 – The Package summary shown for a newly imported Yaris Package, so no ECU serial number or Vehicle  
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Adjust 

The adjust workbook is used for configuring and tuning all the subsystems and parameters in the Package. This replaces 

the workbook dropdown and tabbed worksheet layout as previously found in Tune 1.4. Each workspace can have its own 

variant of this adjust tree. At the bottom of the defined adjust tree is the firmware header, which will contain all the 

parameters in the Package, grouped by name in alphabetical order. This new workbook structure is intended to align the 

workflow in Tune 1.5 more closely with i2. 

 

Figure 29 – Adjust tree navigated to Cam Control configuration worksheet 

This change in worksheet structuring allows for users to navigate through worksheets without requiring use of a mouse. 

Directional keys can navigate through the branches of the Adjust Tree, entering and exiting the desired worksheet with the 

ENTER and ESC keys respectively.  
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Resources 

To complement the existing firmware wiring resource in Tune 1.4, the resources tab has been added for ease of 

visualization of resource assignment or finding what has been configured to a pin on an unfamiliar installation.  

This dedicated workbook is broken up into several worksheets and is the intended location for configuring all I/O 

resources in the firmware, particularly when online with the ECU. You can toggle between all available resources and only 

resource in use (the default setting) with a toggle button  circled in red in Figure 30 below. 

 

Figure 30 – An overview of the Resource workspace 

The time graph has a dedicated IO monitor which will list the currently configured IO resources, the pin number, the 

resource abbreviation as well as the voltage presently measured on that pin. 

The main worksheet area is broken up into two portions – the list of all the I/O resources contained in the firmware, which 

is shown in the top portion of the worksheet and the configuration settings for the currently selected I/O resource from 

the top half of the pane.  

 

Figure 31 – Configuration settings for the selected Fuel Pressure Direct sensor and new graphical resource selection 
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Another new feature in Tune 1.5 to increase to functionality of the software with touchscreen enabled devices is the 

graphical selection interface which will be shown in the right window pane any time a parameter with a dropdown 

selection.  

 

In the gauges section of the workspace, the ECU pinout is displayed with all currently configured pins highlighted. When 

the mouse pointer is held over a configured pin, the function it is assigned to will be shown: 

 

Figure 32 – I/O pinout shown for an M142 ECU 

When an I/O resource is selected assigned, the ECU pin will be highlighted in the pinout. The colour legend for the pins is: 

White – Assigned input/output resource. 

Green – Common sensor resources 5/0V pins. 

Red – 12V Pins. 

Black – Ground Pins. 
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Features 

The features workspace is a quick configure space for engine and vehicle parameters which have a toggle or selection 

mode available. After resources are assigned in a Package, this can be used as a quick central place to enable or disable 

subsystems in the firmware particularly when they have interactions with over subsystems in the firmware.  

 

Figure 33 – Vehicle Features Selection in GPR Drag  

The items shown in this list are not user definable and use a class match in the firmware. These items are selected by a 

feature tagged parameter that’s name ends in ‘mode’ with the first logical enumeration being 0 – Not in use. 

 

Logging 

The logging workspace has had a host of feature updates when compared to Tune 1.4. These changes include increased 

visualisation of logging rate distribution and the ability to set estimated logging levels when an ECU serial number is not 

tied to the loaded Package. 

 

Figure 34 – Overview of the logging workspace in Tune 1.5 
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To speed up assigning logging rates to channels are the logging rate buttons in the centre of the available and logged items 

channel lists. These are interacted with by either dragging and dropping the selected channel/s onto the logging rate 

button or selecting channels and then clicking on the preferred logging rate button. This interaction is completed for both 

adding new channels to the active log set, or for changing the logging rate of the channels selected in the logged channels 

column. 

 

Figure 35 – Logging Setup UI Interface 

On the far right of the workspace are the statistics on the configured logging. In an update from Tune 1.4, the long usage 

bars for logging throughput as well as the memory and channel usage have been replaced with pie charts which also 

contain the numerical percentage of each of these statistics. 

A new feature is the log rate distribution, which shows the distribution of the channels in the currently selected log set’s 

distribution in each sample rate break point. Hovering the mouse pointed over each of these bars will report the number 

of channels configured at this logging rate and clicking on the rate at the top of the bar will filter the Logged Items column 

to only show the channels at that sample frequency.   

The other new feature is the reporting and configuration of the logging can be modified with the toggle as shown on the 

left section of Figure 35. This allows you to toggle the logging configuration and reporting between the known logging level 

of the ECU serial (if the ECU has been connected to the PC previously) or by selecting the DL2 or DL3 toggles, the Package 

can be configured based on the metrics of the Level 2 or Level 3 logging enables.  

 

Figure 36 – New UI for existing logging configuration operations 

Configuration of logging parameters for each log set are handled by the sliders and button tiles in the Top Right of screen. 

Parameter availability, ECU messages, enable conditions and memory reservation and cycling are all configured here.  

There are also button tiles that handle logging configuration repair (circled in magenta) log set import and export (circled 

in blue) and clear logging configuration (circled in orange) 
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Zero Sensors 

The zero sensors workspace is designed to function as a run-up worksheet for quick and easy sensor zeroing or 

recalibration where a ‘Q’ function is assigned to a resource. 

 

Figure 37 – An overview of the Zero Sensors workspace 

The zero-sensor workspace also leverages the new graphical interface allowing for button presses to execute the quick 

calibrate function. This workspace will auto populate with any items that have a ‘Q’ function tied to them, with the time 

graph and status grid auto populating based on the selected item.  

Status 

The status workspace is a status grid for all diagnostic channels found in the firmware. This can be reached with the  

shortcut. This is broken down into groups, in which a group with more than 4 items receiving its own tab in the status grid. 

Clicking on any of the tiles for an individual status item will raise this diagnostic channel in the time graph to allow for 

viewing the behaviour of this diagnostic channel historically during the power cycle.  

 

Figure 38 – Status grid workspace with active diagnostic errors shown 
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Alarms 

This worksheet will display any active alarms while online with an ECU and can be reached via the  shortcut. From 

the tiles on the right side of the screen you can review the alarm history log, edit the alarms as well as acknowledge all 

active alarms – which can also be achieved by pressing the ‘K’ key. 

 

Monitor 

Monitor is a workspace that is intended to be used for real time data monitoring. This workspace allows for time graphs 

and gauges to be configured – no calibrate or parameter windows. Multiple worksheets can be configured in this 

workbook with each sheet name matched to automatically be selected when the matching worksheet is selected in the 

Adjust groups. 

Typical workflow for this workspace is to use it for a secondary window for a second monitor, whether in an office 

scenario with dual monitors, or to have live data available on a second monitor when working on a dyno – which will far 

exceed the scope of what will be available by a dyno to retrieve on CAN.  

 

Figure 39 – Monitoring Workspace configured and exported to a secondary window 

NOTES ON SECONDARY WINDOW 

Moving the Monitor or any other workbook to a secondary window is achieved by right clicking the Monitor tile and 

selecting move to secondary window. 

 

Figure 40 – Right clicking to undock a Workspace into a Secondary Window.  

This can be completed for more than one of the workbooks to streamline workflow when required and can be highly 

beneficial when two monitors are available. 
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Figure 41 – Multiple Adjust Group Workbooks moved over to the secondary window 

When a secondary window is raised, a main tree is generated in the window to allow for the search feature functionality 

to remain for any workbooks in the secondary window. To redock any of the workbooks back into the main window, their 

tile is right clicked and ‘Move to Primary Window’ is selected or the window can be closed to redock all of the workbooks. 

 

Messages 

This workspace will display any notifications such as update availability for currently loaded Packages, software/firmware 

updates available from MoTeC Online, or any current Package errors (such as logging memory allocation) that will prevent 

the Package from being sent.  

 

Figure 42 – Messages Worksheet showing updated workspace templates and firmware update available. 
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Active Item Toolbar 

The interaction tab will dynamically change based on the currently focused object. Visible will be a series of radio buttons 

that will allow for the available interactions with this object. Shown below is an example of the functions available with a 

table. 

 

Show / Hide Channels (Shift + C) 

Minimise/Maximise component (F6) 

Show/Hide Items Pane 

Show Table Graph View 

Show Table Grid View 

Show Table Graph + Grid View 

Show Table Grid + Graph Insert View 

Toggle Table Sliced View 

Swap Axis 

Reverse X Axis 

Reverse Y Axis 

Interpolate functions (with dropdown) (‘I’, ‘H’, and Ctrl + H) 

Smooth Function 

Show/Hide Target (Shift + T) 

Show/Hide Trails (Ctrl + T) 

Show/Hide Touch Controls (‘K’) 
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 ALARMS 

The alarm system has been carried over from Tune 1.4 in many ways, allowing for a large variety of Maths operators to be 

utilised to set alarms which can activate whilst online with an ECU. One functional addition that has been made is the 

ability to raise workspace components based on alarm conditions. Through the tag matching system, either an entire 

worksheet from the adjust group, or through naming convention a particular Gauge or Time Graph can be raised.  

 

Figure 42 – An Alarm based on engine state to raise a gauge based on the engine state being cranking 

In the example shown above, an alarm has been configured to show a status grid of many channel states that would be 

relevant to the engine starting, such as ref/sync states, run switch state and other items. When paired with a secondary 

alarm for the engine state changing to run for the default engine health tab, in instances where the engine syncs quickly 

and runs this gauge will not be raised (when used in conjunction with alarm hierarchy) meaning the gauge change is only 

noticed by the user on instances of extended cranking.  

 

 WORKSPACE CONFIGURATION 

This additional section of the user guide is designed around allowing for a deeper level understanding of the workspace 

environment that now exists in Tune 1.5 as well as outlining the methods of generating and distributing of workspaces.  

A major departure from Tune 1.4 is the dynamic workspace environment provided for configuration and tuning of M1 and 

future ECUs.  

With the added complexity of this functionality, along with the ever-increasing functionality and complexity of the control 

strategies for M1 ECUs, we have determined that the ECU is no longer a suitable medium for the storage of these 

workspace environments. 

With this change, workspaces are now stored locally on your PC. Each workspace you create and name will be stored in 

your workspace directory. These workspaces can be compressed into a template file (. MTF) for ease of distribution, or to 

use as a template base for a new workspace. Workspace templates can also be embedded into exported Packages 

depending on Tune user preferences.  

 

Workspace Templates 

When a Package is opened, a name match search is completed against the locally stored database for what workspace you 

have previously opened this Package against, the matching ruleset from MoTeC Online and if no match is determined, a 

manual selection popup will occur. 
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Figure 46 – Open Workspace Selection when no match is found 

This popup will allow you to match a particular Package to one of your existing workspaces (this popup will list the 

workspaces that exist in your workspace directory), or you can generate a new workspace based on a template from 

MoTeC Online, or one you have previously published.  

 

New Workspace Creation 

If choosing to generate a new workspace to start from, the list of available templates will be listed as options to base the 

new workspace off, or you can import an MTF that are not found in your list. Once you have chosen the MTF file you wish 

to start from, you can name the workspace that you are creating. 

 

 

Figure 47 – Workspace Import Screen in the workspace wizard 
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Setting Custom Time Graphs or Gauge Sets 

In many instances you will want to configure custom time/distance graphs or gauge sets to suit a particular workflow. In 

these cases, you will right click in the header of the dashboard or graph worksheet area and select add new. This will bring 

a popup screen which will allow you to configure the name of the tab. By naming the tab with the same convention as a 

work sheet in the Adjust tree, this will allow the time graph or gauge to be automatically raised when this worksheet is 

selected. The matching of the name follows a matching hierarchy, from an exact name match to partial name match. If the 

name cannot match to any of the adjust worksheets, then it will require manual selection. 

 

Figure 48 – Add New Worksheet dialogue 

As shown above in Figure 48, when you begin to type in a name for the sheet, it will show any Adjust groups that are 

potential matches. The background logic is to raise a worksheet that is an exact match with the workgroup, before raising 

a partial match. This allows for using just the Main adjust group name as the match, so the same worksheet is raised for 

the subsequent subgroups.  

 

Adjusting of Adjust Groups 

The adjust groups can be user configured to suit any particular workflow or firmware. The ability to adjust this is not visible 

to users by default, needing to be enabled through the options menu. This is done under Tools > Options > Applications 

selecting the radio button for Enable ‘Adjust Groups’ Editing shown below. 
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Figure 49 – Enabling adjust group editing from menu. Note: Options menu truncated 

 

Once this is ticked on, a Gear Icon will appear to the right of the Adjust header in the navigation tree. Clicking on this will 

raise the Adjust Group editing workspace.  

 

 

Figure 50 – The Adjust Groups menu used for selecting the worksheets raised for favourites and defining the adjust tree. 

 

The Adjust group editing worksheet is broken down into the following areas: 

Red – This is the Radio button to raise the Adjust Group Editing Worksheet 

Yellow – This is the filter tab to switch between the Firmware and Workspace Adjust group lists 

Green – These radio buttons are for Inserting and removing new groups, as well as reordering them 

Magenta – This is the Favourites group. The calibrate parameters selected here will populate in the Favourites header in 

the adjust group. 

Orange – These radio buttons allow for the manipulation of the parameters under each group.  

Cyan – These radio buttons allow for adding parameters to the Advance filter toggle. 
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Defining the Ordering in Adjust Groups 

When customising the adjust groups or defining a custom workspace from scratch to suit a custom firmware, there are 

several rules that need to be adhered to successfully build an Adjust tree. The order of each group shown in the 

Workspace list is the order that the group will appear in the Adjust Group list. To make subgroups under a main group, a 

forward slash is used. When subgroups are utilised, no calibration parameters are to be placed under the group heading. 

There are no limits to the number of subgroups that can be populated under a group heading, however when populating 

further subgroups under a subgroup, it is recommended not to exceed 4 layers of depth, which is the limit for the 

firmware groups.  

An example of this would be Tuning/Fuel/Efficiency/Compensations.  

 

Figure 51 – Adjust Groups as defined and the output in the menu system 

 

Defining items in an Adjust Group 

Selecting parameters to be contained within an adjust item can be achieved via either the naming match or custom, which 

is manual selection.  

 

 

Figure 52 – Using the match system for selecting items in an adjust group 

 

The match system works with the same key statements of matching in groups as Tune 1.4 using or, and, and not 

statements as well as brackets for grouping. Additionally, ! can be used for not cases. Using keyword matching allows the 

adjust items to group well across multiple firmware’s.  The silver star can be assigned to a single parameter in the group to 

mark it as a favourite, meaning it will be at the top of the list – which will make it the parameter loaded in the workspace 

when the adjust item is selected. 
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When groups are more complex for a control strategy, or when control is required over the order of items appearing in the 

Adjust item, the custom selection should be used.  

 

Figure 53 – Custom Adjust Item configuration 

When a custom matching is selected, clicking on the binocular radio button (circled in green) the search will be available to 

drag and drop the required parameters into the adjust item. With manual selection parameters can be re-ordered using 

the up and down radio buttons.  

To toggle the filtering of any parameter behind the Advance filter radio button, the advance filter box will need to be 

checked. If every item in an Adjust Item is selected to be an advance toggle item, then the Adjust Item will not show up in 

the adjust group list unless the Advance filter radio button is checked on in the task bar.  

 

Saving a Workspace Layout with a Package 

When a workspace is to be paired with a firmware Package, it can optionally be exported from Tune with the Package into 

the Package archive. This allows for the workspace to be installed on installation of a Package when distributed, with the 

installed workspace being a name match for the firmware, which will be installed as an MTFF file in the Package folder of 

the templates directory located in My Documents.  

 

 Figure 54 – Enabling Workspace Template export in the Options Menu 

To enable this functionality the Include Workspace Template in exported Packages radio button needs to be checked on in 

Options > General. 

 

 



 

 

Page  35 

Workspace Template Export to MTF 

Alternatively, a workspace template (.MTF file) can be generated from the file menu to generate a distributable MTF file 

for a Package, or to use as a template base for the create new workspace list.  

 

Figure 55 – Export Workspace to Template function as found through the windows menu 

To Export the currently loaded workspace into a template file, navigating to File > Workspace and selecting Export 

Template… which will open the Workspace Template Export popup. 

 

 

Figure 56 – Workspace Template Export Popup for Icon, Name and Description 

From this popup we name the template, add a brief description and add a .PNG icon for the workspace template which is 

visible in the create workspace menu.  
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Resetting a Workspace or Workspace Components 

When desired, the entire workspace, or components of the workspace are able to be reset or imported from a separate 

workspace. This is managed through the same File > Workspace area as shown in figure 53, with the following Options: 

Reset using Tune 1.5 Workspace Template – This will load the MoTeC best match workspace based on the rules.xml 

Reset using Tune 1.4 Package Layouts – This will use the Package workbooks (if contained in the Package) to populate the 

Adjust Groups and Adjust Items based on the worksheet layout.  

Import Template – This will allow for the import of a MTF template to populate the workspace. 

 

 

Figure 56 – Workspace reset options based on a 1.4 (top) and 1.5 (bottom) sources 

 

Resetting a space using Tune 1.4 layouts will impact everything, as the Package Layouts do not contain the required 

information for populating many areas of the Tune 1.5 workspace. When a workspace MTF is used, there is more 

resolution available for which of the workspace components are returned to default settings.  
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 SHORTCUT KEY GLOSSARY 

As found in the help, below are the keyboard shortcuts as used in Tune 1.5. Some keys have multiple interactions 

depending on where the focus is in the software.  
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